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Part Names

Front

No. Name Function overview

Maintenance cover
Remove when performing manual head cleaning.

P. 70 "Manual Cleaning" 

Front cover Open the cover to load media; in general use, always keep the
cover closed.

Print-head carriage The print heads and blade are inside this section.

[POWER] key This switches the printer on and off.

Cartridge slots Location to install ink cartridges.

Pinch roller When you move the loading lever to the front of the machine,
the media is pinched. The right pinch roller is fixed in place.

Platen This is the path over which the media passes. A print heater
that helps fix the ink are built in.

Media clamps These keep the media from coming loose and prevent fuzz on
the cut edge of the media from touching the print heads.

Blade protector This protects the tip of the blade during cutting.

Grit rollers These rollers feed out media toward the front of the machine.

Introduction
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Rear

No. Name Function overview

Loading lever You operate this when you load media.

USB connector -

Main power switch -

Power-cord connector -

Left media guide Use this guide when loading media. This guide is on the "Left"
when viewing the printer from the front.

Right media guide Use this guide when loading media. The guide is on the "Right"
when viewing the printer from the front.

Discharged fluid cartridge -

Introduction
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Roland BN-20A System Configuration

"VersaWorks 6" is written as "VersaWorks" in this manual.

System Configuration

Output is available in the following combinations.

• Commercial application software + BN-20 driver

• Commercial application software + VersaWorks + BN-20 driver

MEMO

When you use VersaWorks, the BN-20 driver's Printing Preferences become invalid.

Commercially available
application software

Verified application software

• Adobe Illustrator : after CS6
• CorelDRAW : after X3

VersaWorks
This is a software RIP (Raster Image Processor).
For more information, see "VersaWorks Installation Guide."

BN-20 Driver

Driver software that is needed to output printing data from a computer to the ma-
chine.
It is also used to set the printing preferences in the case that you use commercial
application software.

Utility

This is the necessary software to operate this machine. The major functions are
shown below:

• Display of messages and error messages
• Adjustment function
• Management of ink remaining amount
• Maintenance function

 RELATED LINKS 

・  P. 10 "How to Open the BN-20 Driver's Printing Preferences Screen"

・  P. 13 "How to Open the BN-20 Driver / VersaWorks Help"

・  P. 11 "How to Open the Utility Window / Exit the Utility"

・  VersaWorks Installation Guide

Introduction
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Procedure

1. Open [View devices and printers].

• Windows 10

From the start menu, click [Windows System]>[Control Panel]>[View devices and print-
ers].

• Windows 8.1

a. Click [Desk top].

b. Move the mouse to the lower right corner to display Charm and click [Settings].

c. Click [Control Panel]>[View devices and printers].

2. Right-click the [Roland BN-20] icon, and then click Printing Preferences.

The BN-20 driver's Printing Preferences screen opens.

How to Open the BN-20 Driver's Printing Prefer-
ences Screen
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How to Open the Utility Window

Click the  Utility icon on the task tray. (Or, right-click the , and then click [View/Hide].)

The Utility window is displayed.

MEMO

Utility is resident software

Utility is “resident software” that is always running. To hide the window, click  at the upper right of the win-
dow or click [Close]; Utility will not terminate.

If  is not displayed on the task tray, start Utility from the Windows start menu.

Starting from the Windows start menu

Windows 10

From the start menu, click [BN-20 Utility for Windows]>[BN-20 Utility for Windows].

Windows 8.1

1. Click  on the [Start] screen.

2. From the [Apps] screen, click [BN-20 Utility for Windows]>[BN-20 Utility for Windows].

How to Exit the Utility

Right-click the  (Utility icon) in the task tray, and then click [End]. The Utility screen closes.

How to Open the Utility Window / Exit the Utility
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Windows 10

From the start menu, click [VersaWorks]>[VersaWorks].

Windows 8.1

1. Click  on the [Start] screen.

2. From the [Apps] screen, click [VersaWorks]>[VersaWorks].

 RELATED LINKS 

・  https://downloadcenter.rolanddg.com/VersaWorks6

How to Start the VersaWorks
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BN-20 driver

Open the BN-20 driver's Printing Preferences screen, and then click [Help].

 RELATED LINKS 

・  P. 10 "How to Open the BN-20 Driver's Printing Preferences Screen"

VersaWorks

Start VersaWorks, and then click [Help]>[Show Help] from the menu.

Windows 10

From the start menu, click [VersaWorks]>[VersaWorks Help].

Windows 8.1

1. Click  on the [Start] screen.

2. From the [Apps] screen, click [VersaWorks]>[VersaWorks Help].

How to Open the BN-20 Driver / VersaWorks Help
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 RELATED LINKS 

・  P. 12 "How to Start the VersaWorks"

How to Open the BN-20 Driver / VersaWorks Help
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Types of Media

This Master Guide uses the word “media” to mean sheets used for output. Media used with this ma-
chine are broadly classified into two types:

• Roll media: Media wound onto a paper tube

• Sheet media: Any media that is not wound on to a paper tube, e.g. standard size paper sheets

For both roll and sheet media, different types of paper can be selected according to the purpose. For
details contact your media supplier. Media can also be purchased from the Roland DG Corp. website.

 RELATED LINKS 

・  http://www.rolanddg.com/

Usable Media

Some media are not suitable for use with this machine. When selecting media, always conduct a test
and confirm the output quality meets your requirements.

Size

Usable Media

Width*1 • 150 to 170 mm (5.9 to 6.7 inch)
• 200 to 235 mm (7.9 to 9.3 inch)
• 287 to 322 mm (11.3 to 12.7 inch)
• 348 to 383 mm (13.7 to 15.1 inch)
• 393 to 429 mm (15.5 to 16.9 inch)
• 439 to 474 mm (17.3 to 18.7 inch)
• 487 to 515 mm (19.2 to 20.3 inch)

Cuttable media thickness*1 0.22 mm (depending on the media composition)

Maximum media thickness including any
backing paper or release paper*1

For printing only: 1.0 mm
For cutting: 0.4 mm

Roll outer diameter 150 mm

Paper tube (core) inner diameter 76.2 mm (3 in.) or 50.8 mm (2 in.)

 

*1 For both roll media and sheet media
 

Maximum roll weight

6 kg

Other conditions

The following media cannot be used.

• Roll media with inner start section glued to the paper tube (core)

• Heavily warped or curled media

• Media that cannot withstand the heat generated by the media heating system

• Media with a bent or crushed paper tube (core)

• Media that bends under its own weight when loaded

• Media with a bent roll

• Media that is rolled unevenly

About the Media Used
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The following four output methods are available for this machine.

Printing (Only) Printing by using ink. It is also called "Printing Only" as well to distinguish from "Printing and
Cutting."

Cutting (Only) Cutting by using cutter such as for cutting seal. It is also called "Cutting Only" as well to distin-
guish from "Printing and Cutting."

Printing and Cutting
Printing method which performs printing followed by cutting. If sending output data which
contains both printing and cutting information to the printer, cutting operation starts after
printing finishes.

Crop Cut
Outputting method using "Crop Marks" to align printing and cutting result. In a case such as "re-
moving the printed media and performing lamination, and then reloading it and performing
cutting," align them using the crop marks and perform cutting.

Important Points During Use

Use the machine periodically

We recommend using the machine at least once a week. If left unused for a long period of time, the
ink may settle, resulting in unstable discharge (and nozzle clogging). Any dry ink will need to be dis-
charged.

Four Different Output Methods
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Precautions When Operating the Power Supply

IMPORTANT

Make sure that the main power is on at all times
Never switch the main power off. Continuous power on allows the automatic maintenance function to work periodi-
cally. Failure to ensure automatic maintenance will result in a malfunction of the machine, such as damaged print
heads.
During operation, never unplug or switch the main power off.
During operation, if the main power is switched off, or unplugged, the print heads may be damaged. The sub power
switch must always be turned off before the main power is switched off. To turn off the sub power switch, press and
hold down the [POWER] key. If accidentally the main power is switched off, immediately switch the main power and
sub power ([POWER] key) back on again.

Switching the Power On

WARNING When output is not being performed, remove any loaded media or switch off
the sub power.
The continued application of heat at a single location may cause the release of toxic gases
from the media or pose a fire hazard.

Procedure

1. Close the front cover.

2. Switch the main power on.

3. Press the [POWER] key.

When the [POWER] key indicator changes from flashing to steady, startup is completed.

Switching Power On and Off
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Switching the Power Off (Sub-power Off)

Procedure

1. When output is completed, press and hold down the [POWER] key for one second or more.

When the [POWER] key light is off, the power is off.

2. Push the loading lever backward.

Even if you are not going to switch the power off when the machine is not in use, make sure
the loading lever is moved to the rear.

About Sleep Mode (Power-Saving Mode)

The machine has a power-saving function; after about 30 minutes of non-use the machine automatical-
ly changes to the lower power consumption sleep mode. In the sleep mode, the [POWER] key slowly
flashes on and off. When you next operate the [POWER] key or send print data from a computer to the
machine with media loaded, the machine returns to the regular mode.

Switching Power On and Off
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This section describes operations when printing only.

Refer to  "Cutting / Printing and Cutting(P. 38)" ,  "Performing Printing and Cutting Separately(P. 46)" .

Step 1: Loading Media

Loading roll media

Procedure

1. Move the left media guide to the left edge.

(1) Push the loading lever ( ) backward.

(2) Move the left media guide ( ) to the left.

2. Attach the media flange ( ) to one end of the media bar ( ) .

Insert the side of the media bar with a hole ( ) into the media flange.When loading roll media
with a 3-inch paper tube inner diameter, attach the media flange with ( ) on the inside. When
loading roll media with a 2-inch paper tube inner diameter, attach the media flange with ( )
on the inside.

3. Secure the media flange and media bar with the mounting pin ( ).

Printing
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4. Load the roll media onto the media bar.

Install the roll media so there is no gap between it and the media flange.

MEMO

Place the fixed media flange at th e bottom, so that the media feeds in a clockwise direction when looking
from above. You cannot set the media correctly if the feed direction is not right.

5. Place the roll media loaded onto the media bar on the printer.

Press both ends of the media bar into the grooves at the back of the printer while making sure
the media does not become loose.

6. Adjust the loaded position of the roll media.

(1) Move the roll media to the right so the media flange ( ) touches the right media guide ( ).

(2) Slide the left media guide ( ) and press it to the media flange.

Printing
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7. Pass the media through the printer.

Pull the media straight to keep it taut, and let it pass beneath the media clamps ( ).

Not OKOK

CAUTION Do not move the pinch roller by hand. Use the media guide to move the
pinch roller.
Moving the pinch roller by force may result in injury.

8. As shown in the figure, pass the media under the front cover and pull the media out the other side.

9. Start initial operation.

(1) Make sure the left media guide ( ) is pressed against the media flange.

Printing
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(2) Close the front cover ( ).

(3) Pull the loading lever ( ) forward.

Pull the loading lever forward to start initial operation. When the [POWER] key indicator
changes from flashing to steady, initial operation is complete.

Printing
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Loading Sheet Media

Procedure

1. Move the left media guide to the left edge.

(1) Push the loading lever ( ) backward.

(2) Move the left media guide ( ) to the left.

2. Install the cut media.

(1) Move the media to the right, and apply it to the right media guide.

(2) Slide the left media guide and apply it to the media.

(3) Pass the media through the printer.

Pull the media straight to keep it taut, and let it pass beneath the media clamps ( ).

Printing
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Not OKOK

CAUTION Do not move the pinch roller by hand. Use the media guide to move
the pinch roller.
Moving the pinch roller by force may result in injury.

3. As shown in the figure, pass the media under the front cover and pull the media out the other side.

4. Start initial operation.

(1) Make sure the left media guide ( ) is applied to the media.

(2) Close the front cover ( ).

(3) Pull the loading lever ( ) forward.

Pull the loading lever forward to start initial operation. When the [POWER] key indicator
changes from flashing to steady, initial operation is complete.

Printing
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Step 2: Bidirectional Adjustment

Perform adjustment in the following situations. You do not need to perform adjustment in other situa-
tions. Go to  "Step 3: Printing Tests and Normal Cleaning(P. 29)" .

• When using this machine for the first time

• When changing the media to use for the first time

What are bidirectional printing and bidirectional adjustment?

This machine can perform "Bidirectional Printing," which means that the print heads print when
moving in both directions. Bidirectional printing offers the advantage of being able to shorten out-
put times, but subtle misalignment occurs during the outbound and return passes. The operation to
correct these misalignments is called "Bidirectional Adjustment".

BN-20 Driver : How to Perform Bidirectional Printing

Procedure

1. Display the BN-20 driver's Printing Preferences screen.
P. 10 "How to Open the BN-20 Driver's Printing Preferences Screen" 

2. Select [CMYK (v)] from [Ink Mode] on the [Settings] tab.

3. Select [Bidirectional Printing].

Printing
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VersaWorks : How to Perform Bidirectional Printing

In VersaWorks, the bidirectional printing is performed when "draft" is selected in printing quality. For
how to set the printing quality, see [Output Settings]>[Setting the Printing Quality] in Help of Versa-
Works.

Procedure

1. Open the Utility window.

P. 11 "How to Open the Utility Window / Exit the Utility" 

2. Click [Bidirectional adjustment].

3. Click [Test Print].

The test pattern is printed.

4. Read the on-screen instructions and then enter a value in the [New Value] box.

5. Click [Apply].

The value in [Current Value] changes to the entered value.

6. Click [Close].

Printing
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Step 3: Printing Tests and Normal Cleaning

Procedure

1. Open the Utility window.

P. 11 "How to Open the Utility Window / Exit the Utility" 

2. Click [Check Nozzle Condition].

3. Click [Test Print].

The test pattern is printed. Follow the on-screen instructions and check for dot drop-out.

• Nozzle clogging occurs -> Proceed to 4

• Nozzles are not clogged -> Click [Close].

4. Select [Normal Cleaning] and click [Go].

Normal cleaning starts.

Printing
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5. To check for nozzle clogging again

If the nozzle clogging is not fixed, perform [Normal Cleaning] again. For information about
[Medium Cleaning] and [Powerful Cleaning], refer to the following topic.

 RELATED LINKS 

・  P. 68 "Medium and Powerful Cleaning"

Printing
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Step 4: Calibrate Sheet Feeding Amount

Procedure

1. Open the Utility window.

P. 11 "How to Open the Utility Window / Exit the Utility" 

2. Click [Calibrate Sheet Feeding].

3. Click [Test Print].

The test pattern is printed.

4. Read the on-screen instructions and then enter a value in the [New Value] box.

5. Click [Apply].

The value in [Current Value] changes to the entered value.

6. Click [Close].

Printing
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Step 5: Starting Print Output

Procedure

1. Prepare the print data.

2. Output the print data.

• When outputting from commercial application software for creating drawings

Refer to the documentation supplied with your application software.

• When outputting from VersaWorks

Refer to the [VersaWorks Help]>[Basic Operations for Output].

3. Cut the media when outputting is complete.

IMPORTANT

Output Is Not Possible in These Situations

• The machine does not run when a cover (front, or maintenance) is open.
• This machine does not complete startup until the heater reaches the specified temperature, and does not

accept any operation.
When the ambient temperature is low, the heater is slow to warm up. Use the machine in an environment
where the temperature is 20 to 32° C (68 to 90° F).

• Output is not performed when [POWER] key does not stay steadily lighted. After the media is loaded, pull
the loading lever. When the [POWER] key flashes, no operation except for canceling output is accepted.

• If you send the output data in a state where there is no ink left, a warning buzzer will sound and the
machine will stop temporality. A message indicating that ink has run out is displayed in the Status field of
Utilities. When the ink cartridge is replaced with a new one, printing or cutting starts.

Points that must be observed

• Never open a cover (front, or maintenance) while output is in progress. Doing so interrupts printing.
• When you are performing printing, clamp the edges of the media with the media clamps. Otherwise, the

edges of the media may warp and catch on the print heads.
• During output, do not touch the media. Doing so may obstruct the media feed or cause the media to rub

against the print heads, which may result in a paper jam or damage to the heads.
• Keep the loading lever raised when the machine is not in use.

When not using the machine, remove any media and store it in a suitable environment.

• If the machine is left with the media loaded, the media may be damaged, which may adversely affect-
printing. When not using the machine, remove any media and store it in a suitable environment.

Printing
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The output-start location is always the point shown in the figure below.

Print area

Right pinch roller

Print start position

Blade protector

A 1.4 mm

B 5 mm

About the Output-Start Location
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To stop output on the printer side

Procedure

1. Press and hold down the [POWER] key for one second or more during output.

Output stops. You cannot resume output from the stop point.

2. Press the [POWER] key to turn the machine on.

This operation does not cancel standby output data on the computer. Follow the steps below to
cancel data that is still on the computer.

 RELATED LINKS 

・  P. 34 "Canceling Output from the Computer"

Canceling Output from the Computer

Procedure

1. Open [View devices and printers].

• Windows 10

From the start menu, click [Windows System]>[Control Panel]>[View devices and print-
ers].

• Windows 8.1

a. Click [Desk top].

b. Move the mouse to the lower right corner to display Charm and click [Settings].

c. Click [Control Panel]>[View devices and printers].

2. Double-click the BN-20 icon.

Stopping Print Output
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3. Click [Printers]>[Cancel All Documents].

Depending on the computer data transfer status, it may be too late to cancel output. In this
case, you need to cancel output from the printer.

Stopping Print Output

Basic Operations 35



Fully Utilizing the Machine

36



Optimizing the Output Quali-
ty

Cutting / Printing and Cutting........................................................................38
Adjusting cutting .................................................................................38
Accurately Adjusting the Cutting-in Amount.................................................40
Adjusting printing and cutting .................................................................41
Creating Data for Cutting / Printing and Cutting............................................42
Cautionary note on making output with cutting ............................................45

Performing Printing and Cutting Separately ........................................................46
To Perform Printing and Cutting Separately..................................................46
Media Sizes Allowing Automatic Crop Mark Detection......................................46
Printing with Crop Marks ........................................................................47
Aligning Automatically and Cutting ...........................................................49
Crop Cut Adjustment ............................................................................51

Utility : Other Function................................................................................52
Performing Various Adjustments Through a Sequence of Operations ....................52
Setting of Dry Time ..............................................................................53
Resetting All Adjustments to Factory Default Values.......................................55

Optimizing the Output Quality 37



Adjusting cutting
Adjust the cutting conditions to obtain beautiful razor sharp cut lines. Making adjustments to suit the
media thickness.

Procedure

1. Load the media to be cut.

P. 20 "Step 1: Loading Media" 

2. Open the Utility window.

P. 11 "How to Open the Utility Window / Exit the Utility" 

3. Click [Cut Adjustment].

4. Click [Test Cut].

Test cutting is performed.

5. Enter values in the [Cut Force], [Cut Speed], and [Cut Times] boxes.

[Cut Force]

Force at cutting time. If this force is too strong, the blade cuts into the backing paper. (De-
fault setting: 50 gf)

[Cut Speed]

Cutting speed. If the speed is too fast, the cut line is crooked. (Default setting: 15 cm/sec)

Cutting / Printing and Cutting
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[Cut Times]

The number of times to cut the same location. If it is impossible to cut even if you adjust
the cut force and cut speed, increase the cut times. (Default setting: 1)

Check item Result Setting item Adjustment

Check the shape. The cut shape is distorted. [Cut Speed] Reduce

Peel off the circle.
The square also peels off [Cut Force] Increase

Some uncut areas remain. [Cut Speed] Reduce

Peel off the square.

The blade leaves faint traces on the backing
paper.

[Cut Force]

No change

The blade trace is indistinct. Increase

The blade trace is too deep and cuts into the
backing paper Reduce

6. Click [Apply].

Repeat [Test Cut] and adjustment until correctly adjusted.

7. Click [Close].

Cutting / Printing and Cutting
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Accurately Adjusting the Cutting-in Amount

When you want to perform accurate and fine adjustment of the cutting-in amount ( ), such as when
cutting media with thin backing paper, you can obtain good results by adjusting the tip of the blade.
Turn the cap portion of the blade holder to adjust the amount of blade extension. Each indicator tick
corresponds to 0.1 millimeters, and adjustment for 0.5 millimeters can be made by rotating the cap
one full turn.

Note that making the amount of blade extension too small may cause the tip of the blade holder cap
to touch, and may soil and damage the printed surface. It's important to be especially careful about
this when you're using media that has poor ink adhesion properties.

The amount of blade extension ( ) is 0 mm ( ) at minimum and 2.5 mm (98.4 mil) ( ) at maximum.

Rough Estimate for the Amount of Blade Extension

Set the amount of blade extension ( ) to an amount that is the sum of the thickness of the material
portion ( ) and half ( ) the thickness of the backing paper ( ).

Cutting / Printing and Cutting
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Adjusting printing and cutting
When printing and cutting at the same time, adjust and align the printing and cutting positions. De-
pending on the media thickness, sometimes printing and cutting positions are very slightly out of align-
ment. It is recommended to set correction values to suit the media.

Procedure

1. Load the media to be cut.

P. 20 "Step 1: Loading Media" 

2. Open the Utility window.

P. 11 "How to Open the Utility Window / Exit the Utility" 

3. Click [Print and Cut Adjustment].

4. Click [Print and Cut Pattern].

The test pattern is printed.

5. Follow the on-screen instructions and enter the values for [New Scanning Value] and [New Feeding
Value].

6. Click [Apply].

The values in [New Scanning Value] and [New Feeding Value] change to "0."

7. Click [Close].

Cutting / Printing and Cutting
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Creating Data for Cutting / Printing and Cutting

When using VersaWorks, refer to the [VersaWorks Help].

When using application software to create drawings

Verified application software

• Adobe Illustrator : after CS6

• CorelDRAW : after X3

1. Set the color that the BN-20 driver will identify as the cutting line

Procedure

1. Display the BN-20 driver's Printing Preferences screen.
P. 10 "How to Open the BN-20 Driver's Printing Preferences Screen" 

2. Click the [Line Color] button from [CutLine Selection] on the [Printer Adjustment] tab.

The [Color]screen opens.

3. Click [Define Custom Colors].

The Color Settings screen opens allowing you to create colors.

Cutting / Printing and Cutting
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4. Enter values for [Red], [Green], and [Blue].

The BN-20 driver identifies the color specified using the values entered here as the cutting
line, and outputs the color.

Cutting / Printing and Cutting
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2. Creating print data

Procedure

1. Create the print data using application software for creating drawings.

MEMO

Set the Document Color Mode to [RGB]. The color (RGB value) specified as the cutting line may change be-
cause CMYK is converted to RGB when outputting in CMYK mode.
In this case, it may not be possible to perform cutting because the color specified for the driver as the cut-
ting line and the color output from the application software differ.

2. Specify the RGB value set for the part to be identified as the cutting line in step 1. - 4.

If the color for the part you want to print and the color set in step 1. - 4 overlap, redo the
settings from step 1. - 4.

3. Specify the line width for cutting lines as follows.

MEMO

It may not be possible to cut lines of the specified width.

• Adobe Illustrator : 0.001 pt

• CorelDRAW : Hairline

Cutting / Printing and Cutting
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Cautionary note on making output with cutting

Points to Note when Cutting Only

For roll media, let the media hang down to the rear before outputting.

When using the roll media and only performing cutting, let the media hang down to the rear of the
machine. This prevents a motor error or fall of the media caused by the media being pulled with ex-
cessive force.

Do not cut the media before it is taken back if "Take back after printing" is specified in the BN-20
driver.

Do not cut the media before it is taken back when [Rewind Media After Printing] is ON in the [Printer
Adjustment] tab of the BN-20 driver.

When [Rewind Media After Printing] is checked, the media is taken back after printing. If the media
is cut before it is taken back, ink might be ejected to a location where there is no media.

In the case of print and cut, dry the ink sufficiently before cutting.

You can set time for the printer to wait before cutting (Dry Time) with the R-Works, BN-20 driver, or
VersaWorks. The dry time varies according to the media.

 RELATED LINKS 

・  P. 53 "Setting of Dry Time"

Cutting / Printing and Cutting
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To Perform Printing and Cutting Separately

You can remove the printed media and then reload it and perform cutting.

(Example: Perform lamination or other processing after printing, then reload the media and perform
cutting.)

Then, carry out alignment to prevent misalignment of the printing results and the cut lines. Perform
this adjustment in the next Procedure.

Procedure

1. Printing with Crop Marks.

P. 47 "Printing with Crop Marks" 

2. Align to the printed crop marks and perform cutting.

P. 49 "Aligning Automatically and Cutting" 

Media Sizes Allowing Automatic Crop Mark Detection

Pinch roller

Crop Mark

A 65 mm or more

B 22.5 mm

C 1.4 mm

D 60 mm or more

Performing Printing and Cutting Separately
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Printing with Crop Marks
This section describes how to specify settings when using the BN-20 driver. When using VersaWorks, re-
fer to the [VersaWorks Help].

Procedure

1. Display the BN-20 driver's Printing Preferences screen.
P. 10 "How to Open the BN-20 Driver's Printing Preferences Screen" 

2. Select [CropMark] on the [Printer Adjustment] tab.

3. Select [Print].

When [Printing & Cut] is selected, pull back the media after printing the crop mark to start
cutting immediately. Cutting is performed by following the crop mark.

IMPORTANT

Before you start printing, check the media size in the [Settings] tab of Printing Preferences Screen and write
it down. When you perform cutting, set the same media size as the printing. If not, misalignment between
the printing results and the cut lines might occur.

4. Click [OK].

5. Start printing.

P. 32 "Step 5: Starting Print Output" 

The crop marks are printed as shown in the figure.

Performing Printing and Cutting Separately
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 : Align point

Ⓑ : Base point

IMPORTANT

Alignment marks and symbols drawn using a graphics program cannot be used as crop marks.

Performing Printing and Cutting Separately
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Aligning Automatically and Cutting
This section describes how to make settings when using the BN-20 driver. When using VersaWorks, refer
to the [VersaWorks Help].

Procedure

1. Print with a crop mark, and then reload the media that was removed.

Points for Media Setting

Place the crop marks ( ) on the blade protector ( ).

Angled no more than 5 degrees. Otherwise alignment becomes impossible.

2. Display the BN-20 driver's Printing Preferences screen.
P. 10 "How to Open the BN-20 Driver's Printing Preferences Screen" 

3. Select [CropMark] on the [Printer Adjustment] tab.

4. Select [Cut].

Performing Printing and Cutting Separately
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IMPORTANT

Before you start cutting, check that media size in the [Settings] tab of Printing Preferences Screen is the
same as the size used for printing. When you perform cutting, set the same media size as the printing. If not,
misalignment between the printing results and the cut lines might occur.

5. Start cutting.

P. 32 "Step 5: Starting Print Output" 

 RELATED LINKS 

・  P. 47 "Printing with Crop Marks"
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Crop Cut Adjustment
Depending on the composition of the media, the positioning of printing and cutting may be misaligned
even when you're using crop marks. Make corrections for misaligned printing and cutting for the media
you're using.

Procedure

1. Open the Utility window.

P. 11 "How to Open the Utility Window / Exit the Utility" 

2. Click [CropCut Adjustment].

3. Click [Print and Cut Pattern].

The test pattern is printed.

4. Follow the on-screen instructions and enter the values for [New Scanning Value] and [New Feeding
Value].

5. Click [Apply].

The values in [New Scanning Value] and [New Feeding Value] change to "0."

6. Click [Close].

Performing Printing and Cutting Separately
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Performing Various Adjustments Through a Sequence of Operations

You can perform various output adjustments through a sequence of operations by clicking [Adjust All]
on the [Adjustment] tab. The adjustment method is the same as when adjusting settings individually.

When you click [Adjust All], adjustment information is displayed.

[Next] : Continues to the adjustment screen currently displayed on the screen.

[Skip] : Skips the adjustment currently displayed on the screen.

[Cancel] : Cancels the adjustment process.

The adjustments vary depending on the output method. Refer to the table below.

Print (Only) Cutting (Only) Printing and Cutting Crop Cut

Check Nozzle Condition ○ - ○ ○

Bidirectonal adjust-
ment*1 ○ - ○ ○

Calibrate Sheet Feed
Amount ○ ○ ○ ○

Cut Adjustment - ○ ○ ○

Print Cut Adjustment - - ○ ○

CropCut Adjusutment - - - ○

 

*1 This is available when bidirectional printing is set in the BN-20 driver or VersaWorks.
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Setting of Dry Time

This section explains the method of setting the time that the printer needs to wait before it starts
printing or cutting the next page.

Especially, in the case of printing and cutting, ink needs to be sufficiently dried before cutting is start-
ed.

When you make output via the BN-20 driver using a general drawing applica-
tion

Make the following setting in the BN-20 driver first, and then make output from the application.

Procedure

1. Open [View devices and printers].

• Windows 10

From the start menu, click [Windows System]>[Control Panel]>[View devices and print-
ers].

• Windows 8.1

a. Click [Desk top].

b. Move the mouse to the lower right corner to display Charm and click [Settings].

c. Click [Control Panel]>[View devices and printers].

2. Right-click the [Roland BN-20] icon, and then click [Printing preferences].

The BN-20 driver’s Printing preferences screen opens.

3. Set the drying time.

(1) Select [Dry Time] in [Printer Adjustment].

The appropriate setting time varies according to the media. Set longer time when you use
a medium on which it takes time to dry ink.

(2) Click [OK].

When the printer starts drying, the remaining dry time is displayed on the utility.

Utility : Other Function

Optimizing the Output Quality 53



When you make output from VersaWorks

You can set the dry time in VersaWorks as well. For information on its setting method, refer to [Versa-
Works Help].

IMPORTANT

When you set the dry time in VersaWorks, if [Use Printer Settings] is set, 0 is set to the dry time. You should note
that the setting in the BN-20 driver is not reflected.

Utility : Other Function
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Resetting All Adjustments to Factory Default Values

Click [Factory Reset] in the [Option] tab of Utilities, and you can reset all the settings in utilities to
the initial settings.

Click [Factory Reset], and the message shown in the figure is displayed. Click [Yes] to reset the set-
tings.

Utility : Other Function
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Automatic Maintenance Function: Points to Note

This machine has a function to automatically perform periodical maintenance tasks, e.g. to prevent
the print heads from drying out. To ensure the maintenance is properly carried out, please observe the
following points:

• Make sure that the main power is on at all times.

• Do not leave the front cover and maintenance cover open.

Maintenance Schedule

Daily maintenance

To keep this machine in tip-top condition, make sure that daily maintenance is actually performed
every day.

Periodical maintenance

To maintain reliable output conditions, some maintenance tasks need to be carried out at least
once a month.

Switch the sub power on at least every 2 weeks

Switch the sub power on at least every 2 weeks. When the sub power is on, operations to prevent
the print heads from drying out are automatically performed. If the machine is not used for a long
period of time, print heads may be damaged. It is important o make sure to include this task in your
maintenance schedule.

Maintain the temperature and humidity within the specified range

Even when the machine is not in use, maintain the temperature between 5 to 40°C (41 to 104 °F),
with a relative humidity of 20 to 80%, with no condensation. Failure to keep the temperature and
humidity within the specified range may cause a machine malfunction.

 RELATED LINKS 

・  P. 63 "Daily Maintenance"

・  P. 67 "Periodical Cleaning Maintenance"

When Not in Use for a Prolonged Period

In advance, insert ink cartridges that have a large amount of ink remaining.

If the ink runs out, the machine will not be able to periodically perform automatic maintenance. If
the machine is left in this state, the print heads may malfunction. If you know that you will not use
the machine for a prolonged period, insert ink cartridges that have a large amount of ink remaining.

Replace the waste cartridge in advance of prolonged periods of disuse.

If you know that you will not use the machine for a prolonged period, follow the procedure below to
replace the drain cartridge. For information about purchasing drain cartridges, contact your author-
ized Roland DG Corp. dealer.

IMPORTANT

Do not reuse drain cartridges. Doing so makes it impossible to manage the amount of discharged fluid, which may
overflow.

Important Notes on Handling and Use
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 RELATED LINKS 

・  P. 64 "Replacing the Waste Cartridge"
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Checking Ink Levels

Ink levels can be checked in the Ink tab of the Utility window. A simple bar scale indicates the level of
ink in each cartridge. Percentage values also indicate the level of ink remaining. When the cartridge is
removed, [No Cartridge] is displayed.

• MG : Magenta

• CY : Cyan

• YE : Yellow

• BK : Black

* Displayed ink levels are estimates and are slightly different from the actual ink levels.

When an ink level is low, a message appears on the Utility icon on the task tray. Check the ink which is
running out in Utilities and prepare a relevant cartridge for replacement.

Checking Ink Levels and Replacing
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How to Replace Ink Cartridges

When ink runs out, a warning beep is heard and printing is temporarily suspended. Pull out the empty
cartridge and insert a new one. Then printing resumes.

The precipitation of the ingredients in the ink disables printing in normal color. So that the ink mixes
well, shake each ink cartridge 50 times (about 20 seconds) horizontally with a stroke length of around
5 cm (1.97 in.) from each end of the ink cartridge before inserting it.

IMPORTANT

Points to note when replacing cartridges

• Replace with the same type and color of cartridge.

• Insert the cartridge so that the side with the arrow faces up.
• Carefully pull out and insert cartridges one by one.
• Insert firmly, as far as it will go.

• Never mix different types of cartridges.
• Never leave an ink cartridge slot empty. This may cause the print heads to clog up.
• Do not remove or insert a partially used ink cartridge without reason.
• Do not pull out an ink cartridge when the printer is in operation.

WARNING Never store ink, cleaning liquid, or discharged fluid in any of the following lo-
cations.

• Any location exposed to open flame

• Any location where high temperature may occur

• Near bleach or any other such oxidizing agent or explosive material

• Any location within the reach of children
Fire may be a danger. Accidental ingestion by children may pose a health hazard.

Checking Ink Levels and Replacing
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Maintenance of Ink Cartridges

The ink ingredients have a tendency to separate and settle. Allowing the ink to stand can cause the
settled material to harden, resulting in malfunction or other problems.

So that the ink mixes well, periodically shake each ink cartridge 50 times (about 20 seconds) horizon-
tally with a stroke length of around 5 cm (1.97 in.) from each end of the ink cartridge before reinsert-
ing it.

Cleaning

WARNING Never use gasoline, alcohol, thinner, or any other flammable material.
Doing so may cause a fire.

Daily cleaning: wipe off any ink and grime on the media path. The pinch rollers, grit rollers, and plat-
en are particularly subject to grime. Use neutral detergent diluted with water, and a damp cloth to
wipe off ink and grime.

MEMO

• This machine is a precision device and is affected by dust and dirt. Clean thoroughly on a daily basis.
• Never oil or lubricate the machine.

Grit rollers Use a brush to remove any stuck media fibers and waste. Never use a
metal brush.

Pinch rollers Periodically wipe off grime. Failure to wipe clean may result in dirt on
the media.

Platen Wipe off ink and grime left on and waste. Never use a metal brush. the
media path.

Daily Maintenance
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Replacing the Waste Cartridge

When the waste cartridge is filled with waste fluid, the Utility window automatically opens and dis-
plays a message in the Status column that prompts the replacement of the cartridge. Follow the mes-
sage's instructions and prepare a replacement waste cartridge or replace the cartridge.

CAUTION Remove the waste cartridge after the message appears in the Utility window.
If this procedure is not followed, discharged fluid may overflow from the main unit and stain
your hands or drip and stain the floor.

If you know that you will not use the machine for a prolonged period, follow the procedure below to
replace the drain cartridge.

WARNING Never place the drain cartridge or ink near an open flame.
Doing so may cause a fire.

CAUTION Do not open the lid on the drain cartridge.
Any spillage or vapor leakage may cause a fire, odor, or physical distress.

Procedure

1. Remove the drain cartridge.

2. Insert a new drain cartridge.

3. When the dialog box shown below is displayed, click [Yes] .

Daily Maintenance
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IMPORTANT

Do not reuse drain cartridges.
Doing so makes it impossible to manage the amount of discharged fluid, which may overflow.

IMPORTANT

Dispose of discharged fluid properly, in accordance with the laws in effect in your locale.Discharged fluid
is flammable and contains toxic ingredients. Never attempt to incinerate discharged fluid or discard it with
ordinary trash. Also, do not dispose of it in sewer systems, rivers, or streams. Doing so may have an adverse
impact on the environment.

To purchase a waste cartridge, contact your authorized dealer or Roland DG.
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Care and Maintenance of the Print Heads

To ensure optimum printing, the print heads need to be maintained in good condition. There are two
kinds of maintenance: daily maintenance and periodical maintenance.

Daily care and maintenance

Normal Cleaning

We recommend performing Normal Cleaning everyday before the start of operations.
P. 29 "Step 3: Printing Tests and Normal Cleaning" 

Periodical care and maintenance
P. 67 "Periodical Cleaning Maintenance" 

* Print heads are consumable parts and subject to wear. Depending on the frequency of use, periodical
replacement is required. Please order them directly from us or your authorized Roland DG Corp. deal-
er.

Daily Maintenance
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About Periodical Cleaning Menus

There are four levels of cleaning for this machine. Perform the appropriate level of cleaning in accord-
ance with the ink type, the cleaning period, and the machine condition.

When using ECO-SOL MAX/ECO-SOL MAX 2 ink

Normal cleaning
Carry out a printing test. If nozzle drop-out occurs, perform cleaning. 

P. 29 "Step 3: Printing Tests and Normal Cleaning" 

Medium cleaning If nozzle drop-outs are not fixed by performing medium cleaning, perform powerful cleaning.
This consumes more ink than normal cleaning, and too-frequent use may damage the print
heads themselves. Avoid using it more than necessary.

P. 68 "Medium and Powerful Cleaning" 
Powerful cleaning

Manual cleaning
We recommend that you perform this cleaning periodically. Replacing the wiper and felt wiper
is also an effective means of improving the symptoms.

P. 70 "Manual Cleaning" 

When using ECO-SOL MAX 3 ink

Normal cleaning
Carry out a printing test. If nozzle drop-out occurs, perform cleaning. 

P. 29 "Step 3: Printing Tests and Normal Cleaning" 

Manual cleaning

[Clean the printer manually.] is displayed approximately once per week, but it may be dis-
played more frequently depending on the usage conditions. When this message is displayed,
be sure to perform manual cleaning. 

P. 70 "Manual Cleaning" 

Medium cleaning If nozzle drop-outs are not fixed by performing medium cleaning, perform powerful cleaning.
This consumes more ink than normal cleaning, and too-frequent use may damage the print
heads themselves. Avoid using it more than necessary. 

P. 68 "Medium and Powerful Cleaning" 
Powerful cleaning

Manual cleaning
Replacing the wiper and felt wiper is also an effective means of improving the symptoms. 

P. 74 "Replacing the Wiper" 
P. 75 "Replacing the Felt Wiper" 
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Medium and Powerful Cleaning
If dot drop-out is still found after Normal Cleaning, carry out the more powerful [Medium Cleaning] 2
or 3 times. If the condition is still not improved, carry out the even stronger [Powerful Cleaning]

MEMO

Each level of cleaning consumes more ink than the previous level. If these levels of cleaning are performed too often,
the print heads are likely to wear out; do not over clean at any level.

Procedure

1. Open the Utility window.

P. 11 "How to Open the Utility Window / Exit the Utility" 

2. In the [Adjustment] tab, select [Medium Cleaning] and click [Go].

3. Click [Check Nozzle Condition]

4. Click [Test Print]

The test pattern is printed. Follow the on-screen instructions to check for nozzle clogging.

Periodical Cleaning Maintenance
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• Nozzle is clogged -> Proceed to Procedure 5

• Nozzle is not clogged -> Click [Close] to finish

5. Select [Medium Cleaning] and click [Go].

Medium cleaning starts.

6. To check for nozzle clogging again.

If the nozzle condition is not fixed by [Medium Cleaning], perform [Powerful Cleaning].

MEMO

If after several times of Powerful Cleaning, nozzle clogging is still found, perform [Manual Cleaning].

 RELATED LINKS 

・  P. 70 "Manual Cleaning"
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When Manual Cleaning Is Necessary

The timing with which Manual Head Cleaning is required varies depending on the type of ink you are
using. Be sure to perform this cleaning when it is required.

P. 67 "About Periodical Cleaning Menus" 

If the following problems are found, Manual Head Cleaning is recommended

If the following problems occur and any of the automatic cleaning functions have not solved the prob-
lem, perform Manual Head Cleaning.

Please note that replacement of the wiper may also be an effective method to solve a problem.

Nozzle clogging Ink spots Dragged dirt

Dust and dirt stick to the print heads and
prevent normal discharge of ink.

Ink gathers around dirt and grime near
the print heads and ink drops are
formed.

Dragging occurs when dirt around the
print heads comes into contact with me-
dia.

MEMO

• When you need to order the cleaning sticks and cleaning liquid for Manual Head Cleaning, please contact us direct-
ly or your authorized Roland DG Corp. dealer.

• Print heads are consumable parts. Depending on the frequency of use, periodical replacement is required. Please
order them directly from us or your authorized Roland DG Corp. dealer.

 RELATED LINKS 

・  P. 74 "Replacing the Wiper"

Manual Cleaning
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Manual Cleaning Method

IMPORTANT

Requirements for Manual Head Cleaning

• Remove media before cleaning.
• To prevent the heads from drying out, complete the cleaning within 30 minutes. After 30 minutes a warning alarm

will sound.
• Only use the included cleaning sticks. Any other tool, e.g. cotton bud or similar is not designed for this task and

will become fluffy and damage the heads. Please order cleaning sticks directly from us or your authorized Roland
DG Corp. dealer.

• Do not use a cleaning stick more than once; the print quality will deteriorate. Dispose of the stick after each
cleaning.

• Do not soak a used cleaning stick in cleaning liquid; the cleaning liquid will deteriorate.
• Do not rub the nozzle surface of the print heads.
• Clean the sponge section by stroking very lightly and gently. Do not rub, scrape, or flatten the section.

When a warning alarm sounds during cleaning
An alarm sounds 30 minutes after the start of the operation. Perform the operation by following the message dis-
played in the Utility window.

WARNING Be sure to perform operations as specified by the instructions, and never touch
any area not specified in the instructions.
Sudden movement of the machine may cause injury.

Procedure

1. Open the Utility window.

P. 11 "How to Open the Utility Window / Exit the Utility" 

2. In the [Adjustment] tab, click [Manual Cleaning].

Manual Head Cleaning procedures are displayed. Carefully read the on-screen instructions and
start the cleaning tasks.

Manual Cleaning
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3. Carry out test printing and check the result.

Use the cleaning functions and perform cleaning several times if needed.

 RELATED LINKS 

・  P. 29 "Printing Tests and Normal Cleaning"

Manual Cleaning

72  Regular Maintenance



Replacing Consumable Parts
Replacing Parts for Maintenance .....................................................................74

Replacing the Wiper .............................................................................74
Replacing the Felt Wiper........................................................................75
Replacing the Cutter Blade .....................................................................76
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Replacing the Wiper
The wiper is a component used for cleaning the print heads. When the message appears on the Utility
icon on the computer task tray, it is time to replace the wiper with a new one. To purchase a wiper,
contact us directly or your authorized Roland DG Corp. dealer.

When the warning alarm sounds during replacing the wiper

An alarm sounds about 30 minutes after the start of the operation. Perform the operation by following
the message displayed in the Utility window.

WARNING Be sure to perform operations as specified by the instructions, and never touch
any area not specified in the instructions.
Sudden movement of the machine may cause injury.

Procedure

1. Open the Utility window.

P. 11 "How to Open the Utility Window / Exit the Utility" 

2. In the [Replace Tools] tab, click [Replace Wiper].

Procedures for replacing the wiper are displayed. Carefully read the on-screen instructions and
start the replacement work.

3. When the operation is completed, close the front cover.

Replacing Parts for Maintenance
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Replacing the Felt Wiper
The felt wiper is a component used for cleaning the print heads. When the message appears on the
Utility icon on the computer task tray, it is time to replace the wiper with a new one. To purchase a
felt wiper, contact us directly or your authorized Roland DG Corp. dealer.

When the warning alarm sounds during replacing the felt wiper

An alarm sounds about 30 minutes after the start of the operation. Perform the operation by following
the message displayed in the Utility window.

WARNING Be sure to perform operations as specified by the instructions, and never touch
any area not specified in the instructions.
Sudden movement of the machine may cause injury.

Procedure

1. Open the Utility window.

P. 11 "How to Open the Utility Window / Exit the Utility" 

2. In the [Replace Tools] tab, click [Replace Felt Wiper].

Procedures for replacing the felt wiper are displayed. Carefully read the on-screen instructions
and start the replacement work.

3. When the operation is completed, close the front cover.

Replacing Parts for Maintenance
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Replacing the Cutter Blade
When the cutter blade is blunt, the edge is chipped, or the cutting quality has deteriorated, replace
with a new cutter blade.

WARNING Be sure to perform operations as specified by the instructions, and never touch
any area not specified in the instructions.
Sudden movement of the machine may cause injury.

CAUTION Never touch the tip of the knife with your fingers.
Doing so may result in injury. The cutting performance of the blade will also be impaired.

Procedure

1. Open the Utility window.

P. 11 "How to Open the Utility Window / Exit the Utility" 

2. In the [Replace Tools] tab, click [Replace Tools].

If the screen shown in the figure appears, open the front cover and replace the blade.

3. Remove the blade holder.

Replacing Parts for Maintenance
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4. Replace the blade.

(1) Press the pin (A).

(2) Remove the old blade (B).

(3) Install a new blade (C).

5. Support the screw from below and insert the blade holder.

Failure to do this may adversely affect the cutting quality.

6. Firmly tighten the screw.

Tug the blade holder upward to make sure it does not come loose.

7. Close the front cover.

Click [Close].

Replacement is now completed.

Replacing Parts for Maintenance
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8. Make adjustments for cutting.

 RELATED LINKS 

・  P. 38 "Adjusting cutting"

Replacing Parts for Maintenance

78  Replacing Consumable Parts



Troubleshooting Methods.

79



Output Quality Problems
Printed results are coarse or contain horizontal stripes..........................................81

Do the print heads show nozzle clogging? ....................................................81
Have you carried out[Calibrate Sheet Feeding] ? ..........................................81
Have you carried out [Bidirectional adjustment] ? ........................................81
Is the temperature of the room too low?.....................................................81
Is the printer installed in a level and stable location? .....................................81
Is the printer installed in a location out of direct sunlight? ...............................81
Is the media loaded and set up correctly? ...................................................81

Colors are unstable or uneven........................................................................82
Did you shake the ink cartridges gently before installing them? .........................82
Is the media wrinkled? ..........................................................................82
Is the printer installed in a level and stable location? .....................................82
Is the printer being used in a location subject to severe changes in the operating en-

vironment? ..................................................................................82

The media becomes soiled when printed...........................................................83
Are the print heads dirty?.......................................................................83

Cutting is misaligned or skewed......................................................................84
Is the media loaded and set up correctly? ...................................................84
Are the settings for the cutting conditions appropriate? ..................................84
Is the length of output too long?...............................................................84
Are you using media that exhibits large expansion and contraction? ....................84

The printed surface is damaged when cutting .....................................................85
Does the tip of the blade holder cap scrap the printed surface? .........................85

80  Output Quality Problems



Do the print heads show nozzle clogging?
Carry out a printing test and make sure no nozzle clogging occurs. If nozzle clogging is present, per-
form head cleaning.

 RELATED LINKS 

・  P. 29 "Printing Tests and Normal Cleaning"

・  P. 68 "Medium and Powerful Cleaning"

・  P. 70 "Manual Cleaning"

Have you carried out[Calibrate Sheet Feeding] ?
Large misalignment in the amount of feed of the media may result in printing that seems coarse or
contains horizontal stripes. We recommend performing [Calibrate Sheet Feeding] before daily opera-
tions and when changing the media type.

 RELATED LINKS 

・  P. 31 "Calibrate Sheet Feeding Amount"

Have you carried out [Bidirectional adjustment] ?
We recommend performing [Bidirectional adjustment] before daily operations and when changing the
media type. The optimal adjustment value may vary, depending mainly on the thickness of the media.

 RELATED LINKS 

・  P. 27 "Bidirectional Adjustment"

Is the temperature of the room too low?
The heater may not warm up sufficiently when the ambient temperature is less than 20°C (68°F). Al-
so, even when the heater warms up, an adequate effect may not be obtained if the media is thorough-
ly chilled. Before printing, allow the media to come to room temperature.

Is the printer installed in a level and stable location?
Never install the machine in a location where it is tilted or where it may wobble or experience vibra-
tion. Also make sure that the print heads are not exposed to moving air.

Is the printer installed in a location out of direct sunlight?
Never install in a location exposed to direct sunlight.

Is the media loaded and set up correctly?
If the media is not loaded and set up correctly, printing may be adversely affected. Make sure the me-
dia is loaded and set up correctly.

 RELATED LINKS 

・  P. 86 "Media Feed Problems"

Printed results are coarse or contain horizontal
stripes
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Did you shake the ink cartridges gently before installing them?
Shake new cartridges gently before you install them. So that the ink mixes well, periodically shake
each ink cartridge 50 times (about 20 seconds) horizontally with a stroke length of around 5 cm (1.97
in.) from each end of the ink cartridge before reinserting it.

Is the media wrinkled?
If the media is wrinkled and comes loose from the platen, colors may be uneven or printing quality
may suffer.

 RELATED LINKS 

・  P. 86 "Media Feed Problems"

Is the printer installed in a level and stable location?
Never install the machine in a location where it is tilted or where it may wobble or experience vibra-
tion. Also, make sure that the print heads are not exposed to circulating air. These factors may lead to
nozzle clogging or reduced printing quality.

Is the printer being used in a location subject to severe changes in the operat-
ing environment?
Large fluctuations in temperature or humidity while printing is in progress may cause the colors to
change partway through. When you're performing printing, use the machine in a location where tem-
perature and humidity are stable.

Colors are unstable or uneven
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Are the print heads dirty?
The following may cause ink to drip on the media during printing.

• Buildup of fibrous dust (lint) around the heads.

• Ink transferred to the heads due to rubbing against the media.

If this happens, perform manual head cleaning. We recommend carrying out periodic print
heads cleaning.

• Too Low Humidity.

• Use this machine in the environment of 35 to 80 %RH (non condensation).

 RELATED LINKS 

・  P. 67 "Periodical Cleaning Maintenance"

The media becomes soiled when printed
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Is the media loaded and set up correctly?
If the media is not loaded and set up correctly, or media feed is not smooth, cutting may be adversely
affected. Make sure the media is loaded and set up correctly.

 RELATED LINKS 

・  P. 86 "Media Feed Problems"

Are the settings for the cutting conditions appropriate?
Misalignment or skewing may occur if the cutting speed is too fast or the blade force is too high. Try
changing the cutting conditions. With media having a strong adhesive layer, the adhesive layer reat-
taches to itself immediately after cutting. However, if a cutting test shows that the peeling of the me-
dia and the blade traces on the backing paper are optimal, then the media is being cut properly. Be
careful not to make the blade force too high.

 RELATED LINKS 

・  P. 38 "Adjusting cutting"

・  P. 40 "Accurately Adjusting the Cutting-in Amount"

Is the length of output too long?
For printing & cutting in particular, the longer the page length (that is, the longer the distance the
media is returned after printing), the greater is the chance of misalignment occurring. It is a good idea
to keep the size of each single page to the minimum necessary.

Are you using media that exhibits large expansion and contraction?
When you're performing printing & cutting, misalignment occurs if the media expands or contracts. If
this happens, try performing printing with crop marks, then setting the base point and one or more
align points and performing cutting. This corrects for expansion and contraction of the media.

 RELATED LINKS 

・  P. 46 "Performing Printing and Cutting Separately"

Cutting is misaligned or skewed
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Does the tip of the blade holder cap scrap the printed surface?
The tip of the blade holder cap may scrape, and soil or damage the printed surface. If this happens,
increase the amount of blade extension.

 RELATED LINKS 

・  P. 40 "Accurately Adjusting the Cutting-in Amount"

The printed surface is damaged when cutting
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If an error message is displayed because the media has jammed, immediately correct the problem.
Failure to do so may damage the print heads.

 RELATED LINKS 

・  P. 105 "Error Messages"

Is the media warped or wrinkled?
Many factors can cause warping or wrinkling. Refer to the following and correct the problem.

 RELATED LINKS 

・  P. 86 "Media Feed Problems"

The Media Jams
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Is the media loaded and set up straight and securely?
Feed is not smooth when the media is not straight or is tensioned unevenly on the left and right. Re-
load the media.

 RELATED LINKS 

・  P. 20 "Loading Media"

Was loaded media allowed to stand for some time?
Media may shrink or wrinkle if it is heated for an extended time. When printing ends, press and hold
down the [POWER] key to switch off the sub power or remove the media.

Was the media loaded while the heater was hot?
Loading media after the heater has warmed up causes the temperature of the media to rise suddenly,
which may cause the media to shrink or wrinkle during printing. Before loading media, switch off the
sub power and allow the platen to cool.

Is the temperature of room too low?
Use this machine in an environment having an ambient temperature of 20 to 32°C (68 to 90°F). If the
machine is used at an ambient temperature less than 20°C, then depending on the type or width of
the media, wrinkling or temperature-caused unevenness may occur. To obtain stable printing results,
the machine should be used at an ambient temperature of 20 to 32°C (68 to 90°F).

Is the humidity of the room too high?
Use this machine in the environment of 35 to 80 %RH (non condensation).

Is the using media deflected?
If using the deflected media, it cause winkle of the media.

Media Wrinkles or Shrinks
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Is the media loaded and set up straight and securely?
Feed is not smooth when the media is not straight or is tensioned unevenly on the left and right. Re-
load the media.

 RELATED LINKS 

・  P. 20 "Loading Media"

Media Feed Is Not Straight
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Do the media strike some other object?
Make sure the media do not touch anything else. This may affect output, even when feed appears to
be smoothly.

 RELATED LINKS 

・  P. 20 "Loading Media"

Is the media too thick?
Media that is too thick may not only cause unstable feed, but may scrape the print heads, resulting in
malfunction. Never use such media.

Are the grit rollers dirty?
Check to make sure the grit rollers are free of buildup of foreign material such as media scraps.

 RELATED LINKS 

・  P. 63 "Cleaning"

Media Feed Is Not Smooth
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If the print-head carriage stops over the platen, take action immediately to prevent the heads from
drying out.

What to Do First
Hold down the [POWER] key for one second or longer to switch the sub power off, then back on. If the
media is jammed, then also remove the media.

If the print-head carriage move to the standby position (on the right side of the machine), it means
the operation has ended successfully.

If The Heads Still Do Not Move
Try switching off the main power, then again switching on the main power, followed by the sub power.

If the print-head carriage move to the standby
If the heads still do not move after "What to Do First" is performed, carry out the following emergency
response measure, then contact your authorized Roland DG Corp. dealer.

Procedure

1. Switch off the main power and open the front cover.

2. Gently move the print heads to the standby position.

Stopping at the place where the audible click is heard locks the print heads in place.

The Print Heads Stop Moving
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3. Gently apply pressure from the right side to make sure the print heads don't move to the left.

If the print heads move to the left, again move them slowly by applying pressure from the left
side and make sure they lock in place.

The Print Heads Stop Moving
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Is the power switched on?
Switch on the printer's main power, then press the [POWER] key and make sure the key lights up.

Does the [POWER] key stay steadily lighted?
Output is not performed when [POWER] key does not stay steadily lighted. After the media is loaded,
pull the loading lever.

Is the [POWER] key flashing?
When the [POWER] key flashes, no operation except for canceling output is accepted.

Is the cover open?
Close front cover, and maintenance cover.

Has ink run out?
If you send the output data in a state where there is no ink left, a warning buzzer will sound and the
machine will stop temporality. A message indicating that ink has run out is displayed in the Status field
of Utilities. When the ink cartridge is replaced with a new one, printing or cutting starts.

 RELATED LINKS 

・  P. 61 "How to Replace Ink Cartridges"

・  P. 105 "Error Messages"

Is a message displayed on the Utility icon in the task tray or in the Utility win-
dow?

 RELATED LINKS 

・  P. 104 "Messages"

・  P. 105 "Error Messages"

Is the cable connected?
Connect the cable securely.

 RELATED LINKS 

・  BN-20A Preparation Before Use

Is the driver installed correctly?
If the connection to the computer is not made in the sequence described, the driver may fail to be
installed correctly. The Utility does not function normally when driver is misconfigured. Check again to
ensure that the connection was made using the correct procedure.

 RELATED LINKS 

・  BN-20A Preparation Before Use

The Printer Unit Doesn't Run
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Are two or more machines connected to a single computer?
The utility cannot control more than one machine at the same time. Never connect two or more in-
stances of this machine to a single computer.

Is the temperature of the room too low?
This machine does not complete startup until the heater reaches the specified temperature, and does
not accept any operation. When the ambient temperature is low, the heater is slow to warm up. Use
the machine in an environment where the temperature is 20 to 32 °C (68 to 90 °F).

Did you forcibly remove any detachable external storage device connected by
USB?
When you remove the USB removable device (USB flash drive or USB hard disk etc.), you must run
[Safely Remove Hardware and Eject Media] or [Eject] before detaching it. If you remove the USB de-
vice without it in process of printing, the printing may be aborted.

The Printer Unit Doesn't Run
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If installation quits partway through, or if the wizard does not appear when you make the connection
with a USB cable, take action as follows.

Windows 10
Procedure

1. If the [Found New Hardware] appears, click [Cancel] to close it.

2. Right-click the Start menu, and then click [Device Manager].

The [User Account Control] appears, click [Continue]. The [Device Manager] appears.

3. At the [View] menu, click [Show hidden devices].

4. In the list, find [Printers] or [Other devices], then double-click it. When the model name you are us-
ing or [Unknown device] appears below the item you selected, click it to choose it.

5. Go to the [Action] menu, and click [Uninstall].

6. In [Confirm Device Uninstall] window, click [OK]. Close the [Device Manager].

7. Disconnect the USB cable from the computer, and then restart Windows.

8. Uninstall the driver. Carry out the steps from step 3 in "Uninstalling the Driver Windows 10" to unin-
stall the driver.

P. 99 "Uninstalling the Driver" 

9. Install the driver again according to "Preparation Before Use.”

Windows 8.1
Procedure

1. Use a USB cable to connect the machine and the PC, and then turn the machine on.

2. If the [Found New Hardware] wizard appears, click [Settings] to close it.

Disconnect any USB cables for printers other than this machine.

3. Click [Desk top].

4. Move the mouse to the lower right corner to display Charm and click [Settings] .

5. Click [PC Info].

6. Click [Device Manager] . When the [User Account Control] screen appears, click [Continue].

The [Device Manager] appears.

7. Click [Show hidden devices] on the [View] menu.

8. Double-click [Printers] or [Other devices] in the list. Click the model name or [Unknown device],
whichever appears below the item you selected.

9. Click [Uninstall] on the [Action] menu.

10. In the [Confirm Device Uninstall] dialog box, click [OK] to close [Device Manager].

11. Disconnect the USB cable that is connected to the printer, and then restart Windows.

12. Uninstall the driver.

Carry out the steps from step 3 in “Uninstall the Driver Windows 8.1” to uninstall the driver. 
P. 99 "Uninstalling the Driver" 

Installation is impossible
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13. Install the driver again according to "Preparation Before Use.”

Installation is impossible
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When uninstalling the driver, perform following operation.

IMPORTANT

If the driver is uninstalled without following the procedure given below, there is a possibility that it might not be able
to be re-installed.

Windows 10
Procedure

1. Before you start uninstallation of the driver, unplug the USB cables from your computer.

2. Log on to Windows as “Administrator” right.

3. Right-click the Start menu, and then click [Apps and Features].

4. Click the driver for the machine to delete to select it, then Click [Uninstall].

5. A message prompting you to confirm deletion appears. Click [Yes].

Windows 8.1
Procedure

1. Turn the machine off, and disconnect the cable that is connecting the PC and the machine.

2. Start Windows.

3. Click [Desk top].

4. Move the mouse to the lower right corner to display Charm and click [Settings].

5. On the task bar, click [Control Panel] , and then [Programs and Features].

6. Select the machine's driver that you want to uninstall, and then click [Uninstall].

7. When a message prompting you to confirm that you want to uninstall the driver appears, click [Yes].

Uninstalling the Driver
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MEMO

These are cautionary notes on making output from Adobe Illustrator using the BN-20 driver.
They are not applied when VersaWorks is used.

When you want to print in metallic color and when you want to perform cutting, clear the [Print As Bitmap] checkbox in
the [Print] dialog box.

To display the [Print] dialog box, click [File]>[Print]menu.

Set the document's color mode to [RGB].

If you select CMYK mode, the CMYK values will be converted to RGB values when the output is generated. In this case, it may
not be possible to perform cutting because the color specified for the driver as the cutting line and the color output from
Illustrator differ.

Please don't cancel printing by operating Illustrator.

If you cancel printing, press the BN-20 [POWER] key for a few seconds. When you print from Illustrator to BN-20, the now
printing message is displayed. If you click [Cancel] button in the message box, but the printing process is still alive. You cannot
operate the Illustrator untill the end of printing process.

Important Notes When Performing Output from
Adobe Illustrator
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MEMO

These are cautionary notes on making output from CorelDRAW using the BN-20 driver.
They are not applied when VersaWorks is used.

Set the document's color mode to [RGB].

If you select CMYK mode, the CMYK values will be converted to RGB values when the output is generated.In this case, it may
not be possible to perform cutting because the color specified for the driver as the cutting line and the color output from
CorelDRAW differ.

Important Notes When Performing Output from
CorelDRAW
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These are the main messages that appear in the Utility window to prompt correct operation. They do
not indicate any error. There are other messages that appear in the Utility window. Follow the dis-
played prompts and take action accordingly.

[XX ink : Shake the cartridge well]
Remove the ink cartridge that is indicated in *** and shake it well.

 RELATED LINKS 

・  P. 63 "Maintenance of Ink Cartridges"

[The Waste cartridge is full.]
The waste cartridge is full. Replace the waste cartridge with a new one.

 RELATED LINKS 

・  P. 64 "Replacing the Waste Cartridge"

[Replace the wiper.]
It is time to replace the wipers. Replace the wipers.

 RELATED LINKS 

・  P. 74 "Replacing the Wiper"

[Replace the felt wiper.]
It is time to replace the felt wiper. Replace the felt wiper.

 RELATED LINKS 

・  P. 75 "Replacing the Felt Wiper"

[The connection to the printer has been released.]
A USB cable that connects this machine and the computer is unplugged, or the main power of this ma-
chine is switched off. If the machine is allowed to stand with the main power switched off, the auto-
matic maintenance fails to work and it may cause a machine malfunction. Make sure that the main
power is on at all times.

[Clean the printer manually.]
If [Clean the printer manually.] message is displayed on the screen of the computer connected to the
printer, be sure to perform manual cleaning.

 RELATED LINKS 

・  P. 70 "Manual Cleaning"

Messages
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This topic describes some of the error messages that may appear in the Utility window, and how to
take action to remedy the problem. In addition to the messages described below, the Utility window
shows the causes of errors and troubleshooting information. If the troubleshooting information dis-
played in the Utility window or action described here does not correct the problem, or if an error mes-
sage not described here appears, contact your authorized Roland DG Corp. dealer.

[The pinch roller position is incorrect.]
The media size is not acceptable for this machine, and thus the position of the pinch roller is not cor-
rect.
If the pinch roller position is incorrect, the media cannot be secured properly. Specific media sizes can
be positioned properly with the pinch roller on this machine.

 RELATED LINKS 

・  P. 15 "Usable Media"

[Crop marks could not be printed. Output will be canceled.]
The size of the data including the crop marks is larger than the printing or cutting area of the loaded
media.
Make the printing or cutting area wider, such as by replacing the media with a larger piece of media or
by changing the positions of the pinch rollers, then send the data again.

The size of the data being output is too small.
Set the size of the data in the new scanning value (direction in which the print heads move) to at least
65 mm (2.6 in.). Change the size of the data, then send the data again. There is no limitation in the
size of the data in the new feeding direction.

 RELATED LINKS 

・  P. 46 "Performing Printing and Cutting Separately"

[Crop mark detection could not be started.] / [Crop marks were not found.
Output will be canceled.]
Automatic detection of crop marks could not be accomplished.
Load the media at the correct position and perform detection of crop marks again. If repeating auto-
matic crop-mark detection results in an error again, then change the type of media. Depending on the
media, it may not be possible to detect crop marks automatically.

 RELATED LINKS 

・  P. 46 "Performing Printing and Cutting Separately"

・  P. 51 "Crop Cut Adjustment"

[The operation has been stopped to prevent the print heads from drying out.
Turn the printer off.]
The print heads were forced to standby position to prevent them from drying out.
Operation cannot be continued. Switch the sub power off, then back on. Opening the front cover while
printing is in progress causes an emergency stop. Never allow the print heads to remain in this state.

[Motor error]
A motor error occurred.

Error Messages
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Operation cannot be continued. By following the messages displayed in the Utility window, remove the
media, close the front cover, and then hold down the [POWER] key to switch the sub power off. This
error may be caused by such factors as an incorrect loading of the media, a media jam, or an opera-
tion that pulls the media with excessive force. Eliminate the cause of the error before switching the
sub power on, and then reload the media.

[Waste cartridge is estimated to be full]
Output is stopped because the waste cartridge is full.
Output cannot be resumed without correcting this error. Replace the waste cartridge with a new one
by following the message displayed in the Utility window. If a new waste cartridge is not available for
immediate replacement, switch the main power off.

[Temperature error]
The temperature of the location where the machine is installed has risen above or fallen below the
ambient temperature at which the machine can operate.
Operation cannot be continued. Switch off the sub power. Bring the installed location to a tempera-
ture at which operation is possible (20 to 32°C) and allow the machine to come to room temperature,
then turn on the power.

[Cover open error.]
Output is stopped because the front cover or the maintenance cover is open.
Start output again after closing the cover.

[Sheet setup error]
Setup of the media has failed. Load the media correctly.

 RELATED LINKS 

・  P. 20 "Loading Media"

[Data error]
Output was stopped because a problem was found in the data received.
Operation cannot be continued. Check for errors in the data. Check for a problem with the connector
cable or the computer, and start output again.

[Ink has run out.]
Output is stopped because ink has run out.
In the [Ink] tab of the Utility window, check the color of the cartridge that has run out of ink, and
replace the ink cartridge with a new one.

 RELATED LINKS 

・  P. 60 "Checking Ink Levels"

・  P. 61 "How to Replace Ink Cartridges"

[Pinch lever was returned.]
Output is stopped because the loading lever is pushed backward while output is in progress.
Pushing the loading lever backward cancels the setup of the media, so output is stopped. Reload the
media.

Error Messages
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[No sheet is present.]
Output is attempted but it fails because no media is present.
Set up the media.

[Printing cannot continue because the end of the sheet was detected. Print-
ing will be canceled.]
Printing is stopped because the trailing edge of the media is detected.
When the trailing edge of the media is detected, output is cancelled. Load new media.

[ServiceCall No**]
An unrecoverable error occurred, or part replacement that must be performed by a service technician
is required.
An unrecoverable error occurred, or part replacement that must be performed by a service technician
is required.

[Ink Cartridge error : *** ink cartridge ]
A cartridge that cannot be used was installed.
Remove the ink cartridge of the indicated color to clear the error. Use an ink cartridge of the specified
type. ("***" is the color of the ink)

[BN-20 Utility is already running.]
You try to start BN-20 utility though it is already running.
Utility is resident software that remains active even when it is hidden from the screen. When it is hid-
den from the screen, it is located in the task tray in the lower right corner of the computer screen.

 RELATED LINKS 

・  P. 11 "How to Open the Utility Window / Exit the Utility"

[The cleaning liquid cartridge is empty. Replace the cleaning liquid cartridge
with a new one.]
Operation is stopped because the cleaning liquid cartridge is empty.
This message appears when operations such as "Head Wash" are in progress. Operation cannot be re-
sumed without correcting this error. Replace with a new cleaning liquid cartridge immediately. If the
machine is allowed to stand with the empty cartridge, it may result in a malfunction.

Error Messages
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To move the machine, you must completely drain all ink inside the machine and secure the print heads
in place with packing materials to protect them. Attempting to move the machine without first doing
this may result in damage to internal components due to leaking ink or damage to the heads.

What is needed

One piece of unused cleaning cartridge for AQUEOUS PIGMENT ink Three pieces of dummy cartridges

Contact your authorized Roland DG Corp. dealer with regard to items that need to be purchased sepa-
rately.

IMPORTANT

Make sure to use a cleaning cartridge corresponding to ink type. Use of wrong cartridge may cause a machine mal-
function.

Preparing to Move the Machine
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Procedure

1. Open the Utility window.

P. 11 "How to Open the Utility Window / Exit the Utility" 

2. In the [Option] tab, click [Head Wash].

Carry forward the work by following the instructions displayed on the screen. Do not switch off
power during operation until the work is completed.

3. Move as soon as possible.

4. Immediately reinstall the machine and fill with ink.

See "Preparation Before Use" and promptly fill with ink.

IMPORTANT

Important Notes on Moving

• Once the preparations for moving are complete, move the machine and fill it with ink with as little delay
as possible. Allowing the machine to stand without ink may damage the print heads.

• When moving the machine, keep it at a temperature between 5 to 40˚C (41 to 104˚F) and at relative hu-
midity between 20 to 80% (with no condensation). Failure to do so may result in breakdown.

• Handle the machine with care when moving, keeping it level (not tilted at an angle) and preventing it
from striking other objects.

Procedures from Preparing to Move Through Re-
installing
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Maximum Area

The printing or cutting area along the horizontal plane (the direction in which the carriages move) is
determined by the position of the pinch rollers.

Printing or cutting area

Left side pinch roller

Left side pinch roller

Printing or cutting coordinates origin

A Max. 480 mm (18.9 in.)

B Max. 24,998 mm (984.17 in.)

C 5 mm (0.2 in.)

D 1.4 mm (0.06 in.)

Printing Area
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Maximum Area When Using Crop Marks

Printing or cutting area

Maximum area

Crop mark

A 12.5 mm (0.49 in.)

B 10 mm (0.39 in.)

Printing Area
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The cutting conditions and the service life of the blade change according to the media and the operat-
ing environment, even when you're using identical blades. The service life also differs according to the
type of blade. A rough guide is shown below.

Blade Media Blade force Amount of blade offset Blade life (general
guide)*1

ZEC-U1005 General signage vinyl 50 to 150 gf 0.25 mm 8000 m

ZEC-U5025 General signage vinyl
Fluorescent vinyl
Reflective vinyl

30 to 100 gf
120 to 200 gf
100 to 200 gf

0.25 mm
0.25 mm
0.25 mm

4000 m
4000 m
4000 m

 

*1 The values for "Blade life" are estimates for when an identical type of media is used.
 

MEMO

When uncut areas remain even when the blade force is increased to a value that is higher by 50 to 60 gf than the
values shown in this chart, then replace the blade.

About the Blade
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Unit: mm

Dimensional Drawing
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BN-20A

Printing technology Piezoelectric inkjet

Media Width*1 150 to 515 mm (5.9 to 20.3 in.)

Thickness Maximum 1.0 mm (39 mil) with liner, for printing
Maximum 0.4 mm (16 mil) with liner and 0.22 mm (9 mil) without liner, for
cutting

Roll outer diameter Maximum 150 mm (5.9 in.)

Roll weight Maximum 6 kg (13.2 lb.)

Core diameter 76.2 mm (3 in.) or 50.8 mm (2 in.)

Printing/cutting width*2 Maximum 480 mm (18.9 in.)

Ink cartridges Types 220-cc cartridge

Colors Four colors (cyan, magenta, yellow, and black)

Printing resolution (dots per inch) Maximum 1,440 dpi

Cutting blade Type Roland CAMM-1 series compatible

Blade offset 0.25 mm (9 mil)

Cutting speed 1 to 15 cm/s

Blade force 30 to 300 gf

Software resolution (when cutting) 0.025 mm/step

Distance accuracy (when printing)*4 Error of less than ±0.3% of distance traveled, or ±0.3 mm, whichever is
greater

Distance accuracy (when cutting)*3*5 Error of less than ±0.4% of distance traveled, or ±0.3 mm, whichever is
greater

Repeatability (when cutting)*3*6 ±0.1 mm or less

Alignment accuracy for printing and cutting*3*7 ±0.5 mm or less

Alignment accuracy for printing and cutting when
reloading media*3*8

Error of less than ±0.5% of distance traveled, or ±3 mm, whichever is great-
er

Print heater*9 Temperature: 35 °C (95 °F) (fixed)

Connectivity USB (compliant with Universal Serial Bus Specification Revision 2.0)

Power-saving function Automatic sleep feature

Power requirements AC 100 to 240 V ±10 %, 1.0 A, 50 / 60 Hz

Power consumption During operation Approx. 90 W

Sleep mode Approx. 5.5 W

Acoustic noise level During operation 62 dB (A) or less

During standby 42 dB (A) or less

Dimensions 1009 (W) x 582 (D) x 293 (H) mm (39.7 (W) x 22.9 (D) x 11.5 (H) in.)

Weight 36 kg (79.4 lb.)

Installation Environ-
ment

Power on*10 Temperature: 20 to 32 °C (68 to 90 °F)
Humidity: 35 to 80 %RH (non-condensing)

Power off Temperature: 5 to 40 °C (41 to 104 °F)
Humidity: 20 to 80 %RH (non-condensing)

Accessories Power cord, USB cable, blade, blade holder, User's Manual, etc.

 

*1 It must be within the ranges shown below:

• 150 to 170 mm (5.9 to 6.7 inch)
• 200 to 235 mm (7.9 to 9.3 inch)
• 287 to 322 mm (11.3 to 12.7 inch)
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• 348 to 383 mm (13.7 to 15.1 inch)
• 393 to 429 mm (15.5 to 16.9 inch)
• 439 to 474 mm (17.3 to 18.7 inch)
• 487 to 515 mm (19.2 to 20.3 inch)

*2 The length of printing or cutting is subject to the limitations of the program.

*3 • Media type: Media specified by Roland DG Corp.
• Temperature: 25 °C (77 °F), humidity: 50%
• Roll media must be loaded correctly.
• Front margin: 35 mm or more
• Excluding expansion/contraction of the media
• All correction or adjustment function of this machine has been made properly.

*4 With Roland PET film, print travel: 1 m

*5 Range for assured repetition accuracy: Length 1,000 mm

*6 Range for assured repetition accuracy : Length 1,000 mm

*7 • Provided that media length is under 1,000 mm
• Excludes the effects of slanted movement and of expansion and contraction of the media.

*8 • Data size : 1,000 mm in the media-feed direction, 480 mm in the carriage-movement direction
• No lamination
• Automatic detection of crop marks at 4 points when media is reloaded.
• Excluding possible shift caused by expansion/contraction of the media and/or by reloading the media.

*9 • Warm-up is required after power up. This may require 5 to 20 minutes, depending on the operating environment.
• Depending on the ambient temperature and media width, the temperature may fail to be reached 35 (°F).

*10 Operating environment
①: Use in an operating environment with this range.
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